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Plone is a web based Content Management System.  Plone allows users to easily create, edit, and 
publish web pages, documents, news, calendar events, photos, audio, video, and much more to their 
department website.  The following will explain the Plone user interface and methods for using the 
program as the content editor. 
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Website Construction  
A website is made up of pages that can hold different types of content such as text, links, images, documents, 

news, events, etc. 

What is Plone? 
Plone is a web based Content Management System used by UW Oshkosh.  Plone allows non-technical users to 

easily create, edit, and publish web pages, documents, news, calendar events, photos, audio, video, and much 

more to their department website.   

 
Plone has built in modules for surveys, blogs, forums, and many others. 
 

What does a general Plone site look like? 

By default a Plone website is set up with the following areas: header, log in, left, main, right and footer as 

shown in the picture below on the left.  As you can see from the picture below on the right a Plone site can be 

customized.  A customized Plone site will still have common items such as the log in and navigation areas. 

Default Look of Plone Site Default Plone Site UW Oshkosh Customized Plone Site  

 

 

 

 

 

How do I request  a Plone site ? 
To request a Plone site please go to the following link http://www.uwosh.edu/web and fill out the form or call 

424-2442.  Request will be reviewed and prioritized by the web development project team. 

 

Authenticated Log In 
To edit content you must log into your Plone site by using your uwosh email login name and password.  (You 

do not need to type @uwosh.edu) 

To Log In: 

1. At the very bottom of the page next to Copyright information click the log in button 

2. Log in with your uwosh email log in and password 

3. If you do not see a log in button at the bottom of the page you may also find it at the top of the page. 

http://www.uwosh.edu/web
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4. If you do not have a log in on your page at all you can still log in (if you have permissions) by typing in 

/login at the end the site URL up in the address bar (for example:  www.uwosh.edu/training/login  

Plone Environment  
Customized Plone sites may look different than the picture below, but you will still have the same underlying 

mechanisms of navigation and login features to edit your content.  Additional items such as frequently asked 

questions, news items and recent items can be added to a Plone site.  

 

 Header: Will include UW Oshkosh logo and other related links. 

 Departmental Header:  Will be customized to your department. 

 Accessibility: At the top of the UWO template ǇŀƎŜ ȅƻǳ ǎŜŜ ǘƘǊŜŜ ά¢Ωǎέ ǿƘƛŎƘ ǿƛƭƭ ƛncreases font size. 

 Search: Any content can be searched as long as it is public.  This will search content of files such as PDF and 
word documents as well.  This is permission based so if you are signed in as the administrator of the site 
you can also search unpublished items.  

 Bread Crumb Trail: This shows the location of where you are in the site.  This is very useful when you are 
adding content.  When you add a content item it will be added to the location that you are at in your site.  
You can move content items if you put them in the wrong location (see directions on page 12). 

http://www.uwosh.edu/training/login
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 Navigation: The navigation is dynamic so all items will automatically appear (See page 6 for directions to 
exclude items from the navigation).  Your site is set up to only show folders and pages in the navigation.  
The navigation can be located on the left or right area of the site. 

 Portlets: Portlets are items that show on the left or right side of the page such as calendars, news, events, 
call to action items, related links, etc.  These items will show if you currently have information entered.  
You can also customize these portlets to only show on certain pages of your site.  This can be determined 
at site setup. 

 Manage Portlet: If you have privileges to edit the site after you sign in you will see Manage Portlets below 
the navigation area.  Manage Portlets allows you to add portlets (i.e. Calendar, News, Call to Action, 
Related Links, etc.) to the left or right of the page. 

 Contact: This will send an email to the contact person of the site.  This information will be determined at 
the time of site setup. 

 Log in: The login will be at the bottom of the screen to the right of the copyright information.  If the login is 
not in the bottom right corner you can type /login after your web address in the address bar (for example 
www.uwosh.edu/training/login.  Once you have the login screen you can use your UW Oshkosh email user 
name and password to edit a site or to view certain content based on permissions.  This is how the site 
permissions are controlled. 

 Footer: This can be customized to your department information. 

Plone Navigation  
To edit a Plone site you will use the Management Tabs (top), and the Menu Bar (below the tabs). 

Management Tabs ς The Management Tabs, located on the left are used to manage the web content on your 

site. 

Description of Management Tabs 

 
 

 Contents ς This tab will only show for a folder item.  Once you are inside of the contents tab it will show a 

list of all items in your website (i.e. folders, pages, pictures, news, etc.) This can be used to view and edit 

items that are excluded from the navigation. 

 View - shows the content based on the permission of the user that is signed in 

 Edit ς used for updating and making changes to an item 

 Rules ς rules define actions that apply to the item 

 Sharing - setting rights of other users to see or edit content 

 History - shows a history of change for an item and allows you to see and revert to previous versions 

Menu Bar ς The commands on the menu bar, located on the right above are used to add new items to your 

website, display content items within a folder in different ways, and change the state of an item.  Menu bar 

items will vary slightly depending on which type of item you have selected (folder vs. page). 

 

Description of Menu Bar 

 Actions ς allow you to take action for the current folder or page you are on by allowing you to delete, cut, 
copy, or rename that item. 

http://www.uwosh.edu/training/login
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 Display - shows menu choices for setting the display type of a folder item (list view, summary view, etc.) 

(See page 14 for more detail.  

 Add New - shows menu choices for adding content items (images, pages, folders, etc.) 

 State - shows menu choices for setting publication state (private, public draft, public, etc.) 

Navigating  to web site content  
There are three ways that you can navigate to your added items. 

Method 1 (Shown in Navigation) 

If your item is in the navigation simply click on it.  For example you will most likely have a link to your home 

page located in the navigation. 

Method 2 (Excluded from Navigation) 
All items added using Add New on the Menu Bar will be listed under the Contents Tab.  Remember you can 
only see the contents tab if you have a folder selected. 

To view an item in your website that is not in the navigation 

1. In the navigation, click on the home button or the folder that contains the item you are looking for 
2. Click on the Contents Tab 
3. All Content in your website shows as a list 
4. Click on an item to view it 
 
Method 3 (Site Map) 
The site map is an easy way to navigate to content in your site or a site that you are visiting. 

1. Select Site Map In the upper right corner of your screen 
2. Click on the item you want to view 

 

Adding New Items  
The Add New Menu allows you to add content items to your website.  The picture at the right shows what new 

content items can be added. 

By default when adding folders and pages to a site they will automatically appear in the 

navigation for the user who has added it or others that have permission to edit the site.  You 

will need to publish the item if you would like visitors of the site to see it (See Item Status on 

page 7). 

Other Add New Items Description 

Collection A collection is used to search your website for certain 

content without using the search mechanism.  It allows you 

to create a customized folder of your content.  

Event Adds an event to the calendar 

Folder Used to organize your site content 
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File Adds files to your website (i.e. MS Word PDF, MS Excel, etc.) 

Image Adds pictures to your website 

Link Adds a link to your website (allows for key word searches) 

News Item Adds a news item to your website (pictures can also be 

added within a news item) 

Page Creates a new web page in your website 

Adding Folders  
Folders can be used to organize web content (pages, images, and files).  The folder title will be included in the 

web address. 

1. Navigate to the location in your site where you want to add a new folder (determine the location in your 
site by looking at your breadcrumb trail).  (See how to navigate to a webpage or an Item on page 4). 

2. Click Add New on your Menu Bar 
3. Select Folder 
4. Note that you have Content Property Tabs listed at the top of the dialog box (see details on Content 

Properties below) 
5. Type the title of your folder 
6. Type a description of the content that will be in the folder (optional, helps with user key word searches 

and shows if you hover over (mouse over) the link). 
7. Click Save 
8. Note that the folder is listed in the navigation area.  You will need to publish the item if you would like 

visitors of the site to see it. 

Adding Pages 
1. Navigate to the location where you would like to add the page 

2. Click Add New on the Menu Bar 

3. Select Page 

4. Type a Title and Description 

5. (Optional) ς Set Content Properties by clicking on the tabs shown below (Categories, Dates, 

Ownership, Settings) 

6. Type or copy and paste (see copy & paste directions on page 9) (Also see directions for adding 

additional items into your page by using the Editor Toolbar on page 8). 

7. Click the Save button 

Adding Collections  
A collection can be used to create a customized organization of your content.  The content item is stored 

where you originally placed it, but by creating a collection and applying search criterion it appears that your 

content is organized differently.  Adding a collection will create a new folder in the navigation. 

Adding a collection is a two step process. 

Step 1 ɀ Add Collection  

Set up a collection with a Title, Description, and Text.  
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1. Navigate to the location where you would like to store your collection 

2. Select Add New on the Menu Bar 

3. Select Collection 

4. Type the Title, Description, and body text 

5. (Optional) Limiting the number of search results if a number is entered 

6. (Optional) Results may be displayed in a Table and will show the fields that you have indicated 

7. Click Save 

Step 2 ɀ Setting Search Criterion  

Set the search criterion.  This is what will determine the results for the collection. 

1. Click the Criteria Tab 

2. Select the Field name for the search (what do you want to search for?) 

3. Select the Criteria type (this will vary depending upon what field name you are searching  

4. Click Add Criteria (you may add multiple criteria) 

5. (Optional) Set Sort Order 

6. Select Save 

7. Click on your Collection name located in your navigation to see what results have been created 

8. If the results are not correct click on the criteria tab to make your changes 

Content Properties  
When an item is added you will notice content properties that show on four different tabs.  These will vary 

slightly depending upon which kind of content item is being added. 

 

Editing Content Properties  
You can edit content properties after saving an item. 

1. Navigate to the item that you would like to change the content properties 

2. Click the Edit Tab 

3. The content properties appear at the top of the page 

4. Click on the tab of the property you want to change 

5. Click save when you are done making changes 

Exclude Items from Navigation  
LǘŜƳǎ Ŏŀƴ ōŜ ƘƛŘŘŜƴ ǎƻ ǘƘŜȅ ŘƻƴΩǘ ǎƘƻǿ ƛƴ ǘƘŜ ƴŀǾƛƎŀǘƛƻƴ ōȅ ŘƻƛƴƎ ǘƘŜ ŦƻƭƭƻǿƛƴƎ: 

1. Navigate to the item you would like to exclude from the navigation 

2. Click the Edit Tab 

Content Properties Description 

Default  This is the tab used to add a title, description, and content 

Categorization Can be used to add keywords that will help categorize your content 

Dates Set the publish date or expiration date of a page 

Ownership The creator, contributor, and copyright information can be listed here 

Settings Comments, Navigation, Presentation and Table of Contents can be added or 

deleted here 
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3. Click Settings 

4. Check the box Exclude from Navigation 

5. Click Save 

Item Status (View State)  
The state of your content item determines whether it can be viewed by visitors of the site.  By default when 

you create a new item it is private until you change the state.  If an item is private 

(unpublished) it will be red. 

 Private ς The content item will not be available to those who view your site.  

 Publish ς The content is available to those that view your site. 

 Submit for Publication ς Will submit this through workflow for approval before it 
gets published. 

 Advanced- Gives you the option of adding a Publish Date, Including Contained Items (Changes the State of 
the Folder, Subfolder and any items in the folder), Expiration Date, and Comments 

Change State 
You can change the state of an item(s) one of two ways. 

Method 1:  Changing State 

1. Navigate to the item 
2. Make sure that you have the View Tab selected 
3. Select the State Menu 
4. Pick which State you would like to change your content item to 

(Publish, Submit for publication, or Advanced) 
You can also change the state of multiple items. 

Method 2:  Changing the State of Multiple Items 

1. Select the Contents Tab (Remember you can only see the contents tab if you have a folder selected.  It is 

best to start at the home folder. 

2. Check the box in front of the item(s) you want to change 

3. Click the Change State button 

4. Select the Change State option you want (Publish) 

5. Click Save 

 

You can pick the date you want to publish an item.  You can also choose to publish the folder at a different 

time than what you publish the content items inside of the folder.  If you are not linking to the item from a 

different area in the site ƛǘ ǿƻƴΩǘ ōŜ ǎŜŜƴ ƛŦ ǘƘŜ ŦƻƭŘŜǊ ƛǎƴΩǘ ǇǳōƭƛǎƘŜŘΦ 

Editing a Web Page 
After logging in you can edit a webpage using two different methods: 

Method 1 ς Clicking the Edit Tab 

1. Navigate to the item that you would like to edit. 
2. Click the Edit Tab. (Note when clicking the Edit Tab you now see the edit panel 

which includes your content property tabs listed above.  
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3. Make your changes 
4. Click Save 

Method 2 ς Inline Editing 

You can also use inline editing for fast editing of content. 

1. Click anywhere in the editable region of the content. 

Note:  If you click in the editable region of the content instead of using your edit tab it will not bring up the 

entire edit panel, which includes your content property tabs.  

2. Edit your content by making your changes or additions 

3. Click Save 

Editor  Toolbar  
This Toolbar is used to edit the formatting of your text as well as add pictures, internal/external links, anchors, 
tables, and text styles. 

 
 

 
Saves the current page you are working on 

 Bolds the text that you select 

 
Italicizes the text you select 

 
Aligns your text/paragraph to the left 

 
Aligns your text/paragraph to the center 

 
Aligns your text/paragraph to the right 

 
Creates a numbered list 

 
Creates a bulleted list 

 
Definition List (Works well for listing categories and then words with definitions). 

 
Decreases the indent for a  paragraph 

 
Increases the indent for a  paragraph 

 
Insert image 

 
Insert internal link 

 
Insert external link 

 
Insert anchors 

 
Insert table 

 
HTML view (web code view) 

 
Style of text 
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Copy and Pasting Content  
You can copy and paste content from documents or other web pages into Plone.  When you copy into Plone it 

tries to maintain the formatting that you are copying.  It is best to get rid of that formatting. 

To get rid of the formatting: 

1. Copy and paste your text into WordPad or Notepad (this will take away the formatting) 

2. Copy and paste your text from WordPad or Notepad into your Plone site. 

Insert Image  
When creating a website it is best to organize all images in one 
folder (See direction above for creating a folder).  You can 
exclude the folder from the navigation by using the directions 
above (Exclude Items from Navigation).  You will need to 
publish the folder and the images so they can be viewed. 

1. Click the Insert Image Button   on the Editor Toolbar  

2. If the Image is already uploaded to Plone - Select the 

ŦƻƭŘŜǊ ǿƘŜǊŜ ȅƻǳǊ ƛƳŀƎŜ ŜȄƛǎǘ όƛŦ ƛǘ ŘƻŜǎƴΩǘ ŀƭǊŜŀŘȅ ŜȄƛǎǘ ƛƴ ȅƻǳǊ ǎƛǘŜ Ŧƻƭƭƻǿ ǎǘŜǇ оύ 

3. If the Image is not uploaded to Plone ς First select the folder at the left that you want the image to be 

uploaded to (your image folder).  Click ǘƘŜ ¦ǇƭƻŀŘ ƛƳŀƎŜ ƘŜǊŜΧ ōǳǘǘƻƴΦ  

4. Browse to wherever you have the image saved 

5. Select the image you would like to upload 

6. Type in a title for the image (this is searchable) 

7. Type a description for the image (this is searchable) 

8. Click OK 

Editing an Image  
1. Click the image to select it 

2. Click the insert image icon on the Editor Toolbar 

3. Make the changes that you would like for the alignment, size, and text of the image 

4. Click Ok 

Inserting Internal Links  
Internal links are used to link to pages that have already 

been created within your Plone website. 

1. Highlight the text that you want to make the link 

2. Click the internal link button  on the Editor Toolbar 
3. Navigate and select the location in your Plone site that 

has the page you want to link to.  (Note:  If using 
Internet Explorer be very careful selecting the radio button of the file to link to.  If the radio button is not 
selected carefully it may unselect the highlighted text.  If this happens Plone will create a new link at the 
top of the page).   

4. Click Ok 

Inserting External Links  
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External links are used to link to a website page that is outside of your Plone site. 

1. Highlight the text that you want to make a link 

2. Click the external link button  on the Editor 
Toolbar  

3. Type in the URL of the website or copy and 
paste it from the address bar 

4. Click the Preview button to make sure the URL 
is correct 

5. Click OK 

Inserting Email Links  
Email links allow the user to send a message by clicking on the email link. 

1. Highlight the text that you want to make the link 

2. Click the external link button  on the Editor Toolbar 
3. Type mailto:emailaddress with no spaces (Example- mailto:training@uwosh.edu) 
4. Click OK 

Styles 
Styles are a predefined set of formatting.  Heading, Subheading, and Normal Paragraph will likely be the most 

common ones used.  Do not use styles to make your text bigger.  Make sure that you are using the proper 

ǎǘȅƭŜǎ ŦƻǊ ȅƻǳǊ ǘŜȄǘ όƛΦŜΦ ŘƻƴΩǘ ŎƘŀƴƎŜ ǎƻƳŜǘƘƛƴƎ ǘƻ ŀ ƘŜŀŘƛƴƎ ƛŦ ǘƘŀǘ ƛǎ ƴƻǘ ǿƘŀǘ ƛǘ ƛǎύΦ 

1. Highlight the text that you want to format 

2. Select the style dropdown box  on the toolbar  

3. Select the style you want to use  

Note:  The formatting of a style may vary for every website.  Styles such as headings will be defined by the 

designer of the website. 

Anchors  
Anchors are links used to quickly jump to a certain portion of your webpage (other than the top).  You must 

have built in styles to use anchors (i.e. headings or subheadings). 

1. Make sure the text you want to make an anchor has a built in style (i.e. headings or subheadings).  To 

check if there is a style click anywhere in the text that you will be linking to.  Look at the style box on your 

content toolbar as shown below  

2. Type out the text that you want to make a link

 
3. Select the text 

4. Click the anchor button on your toolbar 

5. Select the style your text has that you are linking to (i.e. 

heading or subheading) 

6. A list of text that meets those styles will appear 

7. Select the text you want to link the anchor 

8. Click Ok 

mailto:emailaddress
mailto:training@uwosh.edu
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You can also use the table of contents feature as an alternative to using anchors. 

Table of Contents  
Just like the anchors you must have built in styles to create a table of contents.  The table of contents will show 

at the top of the page 

1. Navigate to the page you want to add a table of contents 

2. Click the Edit Tab 

3. Click the Settings Tab 

4. Check the box in front of Table of Contents 

5. Select Save 

Inserting Tables  
Tables can be used to line up data in your website more efficiently.  Tables in Plone should be used for tabular 

data only. 

1. Select the spot in your website that you want to insert the table 

2. Click the table button  on your Editor Toolbar 

3. Select the style of your table (see examples below) 

4. Enter the number of rows and columns and check the box if you would like headings 

5. Click add table 

   

HTML View 
HTML View can be used by those who want to edit the HTML web programming language.  You should not edit 

this if you are not familiar with web based code. 

1. To view or edit the HTML code click on the html button  on the Editor Toolbar. 

2. To get back to the visual editor click on the html button  on the Editor Toolbar again. 

Zoom 
The zoom icon allows you to expand the editable region to the full web screen. 

1. Click on the Edit Tab 

2. Click on the zoom button  on the Editor Toolbar 

3. To zoom back out click on the zoom button  on your toolbar again 
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Manage Content 

Moving/R enaming/Deleting/Changing State  of an Item  
Just like in many other programs you may decide that you need to move, rename, delete, or change the state 

of an item. 

1. Select the Contents Tab 

2. Navigate and check the box in front of the item(s) that you want to 

change 

3. Select the action you want to perform (Copy, Cut, Rename, Paste, 

Delete, or Change State). 

4. If you want to cut or copy an item(s) to a different location navigate 

to where you would like that item copied to. 

5. Select the check box and click paste. 

Reordering Items in a Folder  
The content tab is used to make any of the above changes to your folders as well as organizing them. 

1. Select the Contents tab 

2. Navigate to the content item that you would like to reorder 

3. On the right hand side of your content items you will see a column called Order: 

4. Click in the order column of the item that you want to move and drag and drop it to the new location.  

(Note:  If you move an item that is listed in the navigation it will also move in the navigation). 

5.  If the item that you want to reorganize is inside a folder click the folder name to view the items inside, 

then follow step three. 

Previous and Next Links  
Previous and Next Links can be used to jump back and forth between pages.  This is similar to a back and 

forward button in a web browser.  Once previous next is enabled on a folder item any pages that you add to 

this folder will automatically include the next previous navigation. 

1. Click on the folder in the navigation to make sure it is selected  

2. Select the Edit Tab 

3. Select Settings on the Content Property Tab  

4. Click the check box to Enable Next Previous Navigation 

5. Select Save 
 

Manage Portlets  
Manage Portlets can be used to add, edit, delete, or move items to the left or right side of the 

site (such as Navigation, Calendar, News, Events, Calendar, Static Text Portlets also know as 

Related Links if using the UWO template or Call to Action items).  Related links are used to add 

a list of links to your site.  Call to action items are used to highlight important items again to 

the right or left side of the page. 

Add Portlets  
1. Log in to the site if you are not logged in  

2. Click on Manage Portlets below the navigation 
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3. You can add items to either the left or right side of the page 

4. Select the !ŘŘ ǇƻǊǘƭŜǘΧŘǊƻǇŘƻǿƴ ƻƴ ǘƘŜ ǎƛŘŜ όƭŜŦǘ ƻǊ ǊƛƎƘǘύ ǘƘŀǘ ȅƻǳ ǿƻǳƭŘ ƭƛƪŜ ǘƻ ŀŘŘ ȅƻǳǊ ǇƻǊǘƭŜǘ ƛǘŜƳ to. 

Add Call to Action  Portlet  
Call to action appears in a portlet in either the right or left column depending on where you 

have add it. Every other entry will automatically have a blue or grey background.  

If you don't currently have a portlet that shows the "call to actions" do the following. You 

will need to have manager privileges or know someone who does. 

1. Login to your site  
2. Choose "manage portlets" which appears at the bottom of navigation.  
3. In the column you want your new "Call to Action" portlet to appear choose the "add portlet" drop down 

menu.  
4. Choose "Call to Action"  

Add new link to call  to action  portlet  

1. Choose "manage portlets" which appears at the bottom of the left or 
right column.  

2. Choose "Call to Action" portlet  
3. Choose "Add Call to Action"  
4. Fill in the text you want your users to see and the URL of the link  
5. Choose "Save" 

Remove Link from Call to Action  

1. Choose "manage portlets" which appears at the bottom of the left or right column.  
2. Choose "Call to Action" portlet  
3. Select the check box next to the item you want to remove  
4. Choose "remove call to action"  
5. Choose "save" 

Remove Call to action  portlet  

1. Choose "manage portlets" which appears at the bottom of the left or right column.  
2. Choose the "x" link next to your "Call to Action" portlet. NOTE you cannot undo this deletion. If you make a 

mistake and delete the "Call to Action" Portlet you will need to recreate it. 

Most Commonly Used Portlets:  

 Navigation:  Used for site navigation 

 Calendar:  Show a Calendar Month and will bold/highlight dates with events and will link to the event if 

clicked on. 

 Event:  Shows upcoming events based on publish state. 

 News:  Show news items based on publish state 

 Recent Items:  Displays a specific number of recent items by date modified 

 Static Text:  5ƛǎǇƭŀȅǎ ǘŜȄǘ ǘƘŀǘ ŘƻŜǎƴΩǘ ŎƘŀƴƎŜ ƻǊ ŀ ƭƛǎǘ ƻŦ ƭƛƴƪǎ όŀƭǎƻ ƪƴƻǿ ŀǎ Related Links if you are using 

the UWO template). 


